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Overview of Zoner Media Explorer and Zoner Viewer

Zoner Media Explorer and Zoner Viewer help you work with graphics and multimedia files.

Imagine you wish to insert an image into a document in a graphics or text editor, and you know what 
folder the image is in, but not its name. Normally, you would have to open the images in the folder one by 
one until you found the right one..
Zoner Media Explorer goes through a folder for you and displays thumbnails of all the images in it. You 
can drag&drop any image you wish into your document. When you double-click on an image's thumbnail, 
Zoner Viewer starts up and displays the image in full size. For faster browsing, you can also set 
"automatic display: - single-click viewing.
Both of these programs can help you convert images to other color resolutions or formats.
Zoner Media Explorer can show the images in a folder as a "slide show", which you can use as a 
presentation. You can also print thumbnails on catalog sheets.
In Zoner Viewer, you can print an image at full size. Both programs let you copy images to the Clipboard.



Tips and Guides
How to view an image or play a file
How to view the files in a folder as a slideshow
How to get more or bigger thumbnails on your display
How to print out a catalog sheet of thumbnails
How to convert images
How to filter out certain file types
How to speed up thumbnail display
How to speed access to important images



Viewing and Playing Files
File | Display/Play    or double-click on the file's thumbnail.

This runs Zoner Viewer and displays the requested image in its window.

In the case of a video or sound file, the program which is associated with this file will be executed.

See also:
Zoner Viewer Functions



Opening a Favorite Folder
File | Favorite Folders

In this submenu, you can choose a folder from among your Favorite Folders, those you have marked as 
holding your favorite files.

See also:
Favorite Folders



Printing Thumbnails on a Catalog Sheet
File | Print… or Ctrl-P

This option prints out a catalog sheet of thumbnails in the currently active folder. 

If you want to print individual images at full size, do so from Zoner Viewer, or import the images into Zoner
Callisto and print from there.



Format Filter Settings

View | Filter | Properties… or click on items in the list of file formats.

This will call up a dialog listing the file formats supported by Zoner Media Explorer. Here you can select 
which file formats should be displayed by checking the name of their suffix, and/or toggle the display of all
bitmap, vector, animation, and sound file types.
Click OK and the display will be automatically updated - it is not necessary to refresh the display.



Thumbnail Cache Memory

To create the bitmap thumbnails it displays in its main window, Zoner Media Explorer must load each 
image and create a 60x80 pixel version of it. This operation can be quite time-consuming for more 
extensive bitmaps. Imagine, for example, that you are working with images that are several megabytes 
large. Every time you open a folder with such large pictures, they must be read one by one. Therefore it's 
useful for the program to save thumbnails as they are created, and quickly display them each time the 
folder is re-opened, instead of creating them again out of large files.
Some applications solve this situation by creating new (generally smaller) thumbnail files for every bitmap 
image in a folder.  This solution is far from perfect, as the number of files in a folder can grow out of 
control before a user's eyes.
Zoner Media Explorer's solution, based on experience from Zoner's older Archive program, is to save all 
thumbnails for a given folder to a single LIFO database file, where thumbnails of all images over a certain 
size, which the user can choose, are saved, and new thumbnails, after a certain number, write over old 
ones. Media Explorer also saves only the necessary color depth and dimensions of images, which also 
saves space and speed.

See also:
Cache Memory Settings



Favorite Folders
Zoner Media Explorer, like other Windows 95 applications, can keep a list of which folders hold your 
favorite images. You can add items to this list.

Information on Favorite Folders is saved together with similar information for other Windows applications, 
in the "\Windows\Favorites" directory. There is a special folder for Media Explorer items here. The 
contents of Favorite Folders are not stored there, just the names.

See also:
Adding to Favorite Folders
Opening a Favorite Folder



Zoner Media Explorer Functions
Viewing and Playing Files
Automatic Display
Slideshows
File Information
Printing Thumbnails on a Catalog Sheet
Format Filter Settings
Thumbnail Size Settings
List Display Settings
Converting Images
Editing Images
Refreshing the Display
Thumbnail Cache Memory
Integration into the Windows System
Thumbnails for animations and video sequences
Acquiring an image from a scanner

Selecting Files:
      Select All
      Deselect All
      Invert Selection

Working with files and folders:
      Renaming Files and Folders
      Copying and Moving Files
      Deleting Files or Folders
...Creating a New Folder
      Inserting Files into other Applications

See also:
Toolbar



Zoner Media Explorer Menus
Zoner Media Explorer contains the following menus:

File
Edit
View
Tools
Help

See also:
Toolbar



Comparison with Zoner Archives program
Zoner Archives program is available together with vector graphic editor Zebra for Windows 1.5. It is 16-
bit application and you can run it in MS Windows 3.1 system. 
Zoner Archives can help you with images managing and with conversions. There is a possibility to create
images catalogs in this application, too.

What are advantages of Zoner Media Explorer against Zoner Archives ?

• It is 32-bit application and therefore is faster,
• more supported graphic formats,
• work with multimedia files,
• better viewing of folder structure,
• better viewing of files list,
• better solution in images viewing. Images will be displayed in additional Zoner Viewer program,
• more images can be displayed together, 
• possibility to show images in folders (slide show),
• possibility to change a size of viewing thumbnails,
• better philosophy in thumbnails saving,
• possibility to cut some parts of bitmap images,
• better system of cache memory for already created thumbnails,
• images inserting into Clipboard,
• images printing,
• binding into MS Windows 95 and MS Windows NT 4.0,
• basic module of Zoner Media Explorer can be called with OLE from graphic editor Zoner Callisto 



Associations of Files with Programs
For every file type, Windows keeps information about which program, if any, should be used to open it. 
For example, when you double-click on the icon of a BMP image, it will be opened in Paintbrush.

Most programs save this information (called the format's "association") into the Windows system on 
installation.
Sometimes a different program than the one you wish becomes associated with a format. This is because
the "unwanted" (generally new) program, when you installed it, changed the original association of that 
file type.
To change associations, use the My Computer application in Windows. The Display | Options... item will 
call up a dialog containing a tab called File Types. This tab contains detailed options for working with file 
associations.



Automatic Display
View | Automatic Display

When this option is on, a single click on a thumbnail or an item in    the file list (top right) will tell Zoner 
Media Explorer to call up Zoner Viewer for displaying images.
When this option is on, there is a checkmark by its menu item.
When automatic display is turned off, you must double-click on an image to view it. Single-clicking on an 
item will select it.
Automatic display is useful when you want to browse through many images quickly. Position the Media 
Explorer and Viewer windows beside each other, turn on automatic display, and then bring display them in
the Viewer by single-clicking on them.

See also:
Viewing and Playing Files



Slideshows
Tools | Slideshow… or F3

This will call up a dialog where you can set slideshow parameters. Zoner Media Explorer displays images 
in alphabetical order. By giving your images appropriate names, you can make them into a slideshow. 
"Appropriate" here means naming them in numerical or alphabetical order, matching the order in which 
you want them to be displayed.

Slideshow options:
• switch pictures manually - the Manually option.
• switch pictures after a certain time interval - the Automatically every x seconds option.
• automatically repeating show - the Repeat show after last picture option.
• display filename at top of screen - the Display file name and path option 
• make a slideshow of the selected files only - the Only selected files option 
• make a slideshow of the current folder - the All files in current folder option.
• make a slideshow of the current folder and its subfolders - option the All files including subfolders.

How slideshows work:
Zoner Viewer will be opened to display the pictures. The images will be displayed one by one against a 
black background. To interrupt the slideshow, right-click. A popup menu will appear; in it, you can choose 
among the following options:
- change slideshow interval (automatic shows)
- move forward or back one picture (manual shows)
- toggle the display of filenames
- exit slideshow



Selecting Files
All your file operations will only affect files you have selected. 

Items are selected using the same methods as in other Windows programs.
• To select one file, click on it; this will also deselect all previously selected files.
• To select several items, press Shift as you select them (this will make the item under the cursor the 
beginning or end of a sequence of selected items) or Ctrl (the item under the cursor will be selected, 
without canceling your other selections).
• To select all items, press Ctrl-A or use Edit | Select All. 

To cancel your selection, press Esc. To invert your selection, use the Edit | Invert Selection menu item. 

You can select items in both the file list and the thumbnails window, and combine selection freely among 
them.



File Information
File | Properties…

To obtain detailed information on the current image or file, use this option. 



Formats Supported
Zoner Media Explorer and Zoner Viewer support the following formats:

Bitmap images:
BMI - Bitmap Image. ZONER software's internal format, with a high compression ratio
BMP - Windows Bitmap. Standard Windows format, no compression.
DIB - Device Independent Bitmap. Bitmap format designed for high compatibility.
GIF - Compuserve's Graphic Image Format. This format is widely used on the Internet but cannot save 

images with more than 256 colors. 
ICO - Windows Icon. The format for saving icons.
JPG - Format with an excellent compression ration. This format is widely used on the Internet.
MAC - Macintosh format
PCX - ZSoft Image File. Graphic format with medium, but quick compression. 
PNG - New format similar to the GIF format that cannot save images with more than 256 colors. The 

format is very complicated .
RLE - Compressed BMP format using RLE compression. 
TGA - TrueVision Targa.
TIF - Tagged Image File Format. This format is widely used in publications. It has many versions; Zoner

Media Explorer supports all of them.
WPG - Word Perfect Graphic. The bitmap version of this format.

Vector-based images:
CDR - CorelDraw! image. Zoner Media Explorer supports versions 3 and 4.
EMF - Enhanced Metafile.
WMF -  Windows Metafile. The standard vector format in Windows.
ZBR - Image from Zoner's Zebra for Windows graphics editor
ZCL - Clipart from Zoner Callisto
ZMF - Zoner Callisto document
DXF - Format for technical design..(AutoCad).
HPG - Hewlett Packard Graphic Language

Multimedia files (supported by Zoner Media Explorer, but not Viewer):
AVI - Video file.
MID - Sound file 
WAV - Sound file.



Refreshing the Display
View | Refresh or F5

This makes Zoner Media Explorer reload the contents of the current folder and redisplay its items. This 
option is especially useful when you have just worked in another application and added files to the folder 
you are viewing, and you want Zoner Media Explorer to display them.



Thumbnail Size Settings
View | Thumbnail Size or use the slider on the toolbar.

You can adjust the thumbnail size, which also affects the number of thumbnails which can be displayed at
one time. The following sizes are available (they correspond to the above-mentioned menu options).

Small
Small with Name
Normal
Large
Largest



Toolbar
Zoner Media Explorer's toolbar contains the following items:

    Move up one folder

..Favorite Folders

    Copy to Clipboard

    Convert Image

    Print Catalog Sheet

    Short List

    Detailed List

    Thumbnail Size Settings

    Format Filter Settings

    Cache Memory Options

    Slideshow

See also:
Zoner Viewer Toolbar



Small Thumbnails
View | Thumbnail Size | Small or use the slider on the toolbar.

This option displays thumbnails only, with filenames and frames, so as many as possible can fit in the 
Media Explorer window. This setting is most useful when you are using the Media Explorer as a tool for 
quickly browsing through images, then dragging them and dropping them into other applications - so the 
files' names matter little. When you move the mouse cursor over a thumbnail, its name and full path are 
displayed.

See also:
Thumbnail Size Settings



Small Thumbnails with Names
View | Thumbnail Size | Small with Name or use the slider on the toolbar.

This displays thumbnails without a frame. This is the option which will be most useful most of the time. 
When you place the cursor over a thumbnail, its full name and path name will be displayed. 

See also:
Thumbnail Size Settings



Normal Thumbnails
View | Thumbnail Size | Normal or use the slider on the    toolbar.

This displays thumbnails with frames. When you place the curs r over a thumbnail, its full name and path 
name are displayed.

See also:
Thumbnail Size Settings



Tools Menu    
The Tools menu of Zoner Media Explorer contains the following items:

Convert...
Edit...
Slideshow... 
Add Image from Scanner



Large Thumbnails
View | Thumbnail Size | Large or use the slider on the toolbar.

This displays large thumbnails, with frames. When you rest the cursor over a thumbnail, its full name and 
path name will be displayed.

See also:
Thumbnail Size Settings



Largest Thumbnails
View | Thumbnail Size | Largest or use the slider on the toolbar.

This will display very large thumbnails, with frames. When you rest the cursor over an item, its full name 
and path will be displayed.

See also:
Thumbnail Size Settings



File Listing Method

View | File Listing Method or use the toolbar button.

Options:
• short list (filenames only): the List menu item.
• detailed list: the Details menu item.

The list in question is the upper right section of the application window. It lists the same files as are 
displayed in the thumbnails area. You can select items in this list just as you would in the Windows '95 
Explorer.



Thumbnails for animations and video sequences
View | Thumbnail Video

The thumbnail section of Zoner Media Explorer displays miniatures of images, the first image in animated 
GIF files, the middle image of AVI video sequences, and symbols representing sound files.

If you want to view an animated GIF or a video sequence directly inside of its thumbnail, click on it so it is 
selected. The sequence will immediately be played. In the case of AVI video sequences, this involves a 
significant data flow, which can be problematic for the user if it is launched every time a video file is 
selected. This is especially a problem for users of network drives. To turn off the display of video 
sequences inside of thumbnails, use the View | Thumbnail Video menu item. This option does not 
change the results of the traditional AVI viewing method (double-clicking), which displays the video in a 
special application.

See also:
Viewing and playing files



Editing Images
Tools | Edit…

This calls up the application associated    with the currently selected image and loads that image into the 
application's environment.



Selecting All Files
Edit | Select All or Ctrl-A

To select all items in the current folder, use this option.

See also:
Selecting Files



Inverting File Selection
Edit | Invert Selection

This option cancels the selection of all items you have currently selected in a folder, and selects the 
remaining items.

See also:
Selecting Files



Canceling File Selection
Edit | Deselect All or Esc

This deselects all files you have selected.

See also:
Selecting Files



Renaming Files and Folders
File | Rename

This option makes the selected item's title editable - you can rewrite it. This is the way to rename a file or 
folder.
The Windows 95 and Windows NT systems support long filenames, so you can use them in Zoner Media 
Explorer as well. The Windows 95 method of renaming items is also supported, i.e. you can click on a 
name and it will become editable. Once the new name is ready, press Enter or click anywhere outside the
name being edited.
Be careful with file extensions. Don't rewrite the file extension, thinking Zoner Media Explorer will 
automatically convert it. It won't, and your file will become unreadable unless you change the name back. 
Instead, use a file conversion function, like the one available from the Tools menu.



Moving and Copying Files

In Zoner Media Explorer, you can freely move a file or group of selected files using the drag and drop 
method.
Files can be moved and copied not only inside the program, but also to and from Windows Explorer and 
the folder display in the My Computer application.
The methods for copying and moving files are entirely the same as in the Explorers for Windows 95 and 
NT.

See also:
Working with the Clipboard



Deleting Files or Folders
Edit | Delete Selected or Del

To delete all selected files or folders, use this option. 
If these items are on a local hard disk, they will be thrown into the recycle bin of the Windows 95 system. 
If you wish them not to go to the bin, i.e. to be fully deleted right away, use Shift-Del for deleting.



Inserting Files into Other Applications
Zoner Media Explorer offers two methods for inserting files into other Windows applications.

1. Dragging items: For this, both the Media Explorer window and the window of the application where 
you wish to place the file must be visible. Drag the item from Zoner Media Explorer into the window of the 
other application, and drop it. If the other application does not support the required format, the mouse 
cursor will change to a "no entry" sign.
Windows 95 and Windows NT 4.0 also let you insert a file by dragging it over a program icon in the 
taskbar. When you drag the item over the program's icon and wait a few seconds, the program will open. 
Then move the item into the program's application window. Drop the item into this window. 
If you select several items, all of them will be passed to the other application. However, most applications 
can only load one file in this manner.

2. Copying and pasting items: You can cut/copy items to the Clipboard to move them between the 
Media Explorer and another application. This method is convenient when the application with which you 
wish to work does not support drag&drop.



Cache Memory Options
View | Options…

Here you can set parameters affecting the cache memory for thumbnails.

Maximum thumbnails in cache
In this editing field, enter the maximum number of thumbnails you wish to be in the cache. Once the 
program creates image thumbnails beyond this count, the oldest ones will be erased. One thumbnail 
occupies from 1 to 5 kB on the disk. Thumbnails for images in TrueColor (16 million) color depth tend to 
occupy a lot of space.

Save thumbnails larger than
This tells Zoner Media Explorer what should be the smallest images for which thumbnails are made. It's 
unnecessary to save thumbnails for quite small images.

The default settings are to store 200 thumbnails in the cache, and to store only thumbnails of files 48 KB 
and larger.

See also:
Thumbnail Cache Memory



Add to Favorite Folders
File | Add to Favorite Folders

This adds the currently selected (highlighted) folder to the Favorite Folders list.

See also: 
Favorite Folders



File Menu    

The File menu of Zoner Media Explorer contains the following items:

Display/Play
Properties...
Rename
New Folder
Print
Page Setup
Favorite Folders
Add to Favorite Folders

Exit



Page Setup
File | Page Setup…

This calls up the standard Windows dialog for selecting print settings and a printer.



Creating a New Folder
File | New Folder

This creates a new folder, with the name "New Folder," as a subfolder of the current folder.

See also:
Renaming Files and Folders



Exiting the Program
File | Exit or Alt-F4

This option exits Zoner Media Explorer. It also closes Zoner Viewer, if it is running.
But note that Zoner Media Explorer does not close when you exit the Viewer.



Edit Menu
The Edit menu of Zoner Media Explorer contains the following items:

Copy
Paste
Select All
Deselect All
Invert Selection
Delete Selected



Working with the Clipboard
copying files: Edit | Copy or Ctrl-Ins / Ctrl-C
pasting files: Edit | Paste or Ctrl-V

To put the selected file in the Clipboard so it can be pasted elsewhere in Zoner Media Explorer or in other 
applications, use this option.



View Menu    
The View menu of Zoner Media Explorer contains the following items:

Automatic Display
Thumbnail Videos
Toolbar
Status Bar
Filter
Thumbnail Size 
File List Method
Refresh
Options...



Status Bar
View | Status Bar

This turns the display of the status bar on and off. 

Zoner Media Explorer's status bar offers some important information:
- the progress of program operations (e.g. image loading)
- help for the current menu item
- total number of supported (i.e. graphics/multimedia) files in folder
- number of files displayed
- number of selected files
- the disk space occupied by the selected items

Zoner Viewer's status bar offers the following information: 
- the size and the color depth of the current image
- the position of the selected area, if any, of an image
- the dimensions of the selected area, if any, of an image



Showing and Hiding the Toolbar
View | Toolbar or Ctrl-T

This switches the toolbar display on and off.

See also:
Zoner Media Explorer Toolbar 
Zoner Viewer Toolbar 



Help Menu
The Help menu of Zoner Media Explorer contains the following items:

Help Contents
About...



About
Help | About...

This calls up a dialog with information about the producer and the license.



Help Contents
Help | Help Contents

This will call up the table of contents for Zoner Media Explorer help.



Thumbnail
A thumbnail is a small image that is used for displaying images quickly and showing many images at 
once.

This term is used in DTP for small images with low resolution - a lower quality than the original image. 



Acquiring Image from Scanner
Tools | Add Image from Scanner...

This option calls up Zoner Viewer's scanning function.

A dialog appears for selecting a scanner (if more than one is available) and starting the scanning process.
If you check the Display scanner's user interface option, then the standard dialog for setting parameters, 
which you received with the scanner driver, will be used. Otherwise, the image will be immediately 
scanned into the Zoner Viewer environment.
To save the image after scanning it, use the File | Save menu item.

If scanning fails, this means the program could not link to the scanner. Zoner Viewer communicates using 
the standard TWAIN interface, supported by a vast majority of scanners. If you own an older scanner or 
your scanner does not support TWAIN, then you should scan your images using the utility supplied with 
the scanner before starting your work in Zoner Media Explorer.



Converting Images

Tools | Conversion… in both Zoner Viewer and Zoner Media Explorer

When you request conversion of a single image in Zoner Media Explorer, the Viewer is called up to 
display the image during conversion. When it is requested with several images selected, the Viewer is not
activated. In both cases, an extensive dialog with several tabs for setting conversion parameters is called 
up. 

To work with image conversion, you need at least a minimal understanding of image formats. The 
program can convert bitmap formats among each other, and vector formats to bitmaps.

The tabs of the conversion dialog include:

File/Files
Here you choose the concrete filename(s), and especially format, for conversion. When you convert to a 
format which does not support all color depths (e.g. GIF or MAC), the color depth of your image may be 
reduced. When converting several images at once, enter the mask for automatic renaming of the new 
files.

Dimensions
When you wish to change the dimensions of a new bitmap image, enter the new dimensions here. The 
original dimensions are displayed in the dialog's title bar. 

Color Depth
In this section, you enter the number of colors which should be used in the resultant image. Not all depths
are available for all formats. For example, you cannot create a GIF with 24-bit (TrueColor) color depth. 

Compression
Choose a compression method appropriate for the format. The TIF format, for example, supports all 
compression types, but compression is also often a barrier to its readability in other applications. For 
example, some programs do not know how to read TIF in CCITT compression.
JPG compression involves a loss of quality. How much is lost depends on the parameter you enter here. 
The default value (75%) represents a reasonable compromise between compression level and picture 
quality.
For the GIF format, you can check the interlaced option, which means that the image will not be 
displayed in one sweep from top to bottom, but in several sweeps with a gradual improvement in quality. 
This format modification is used primarily for publishing on the Internet, where loading a whole image 
from a distant server can be quite slow, but a rough image can quickly give the reader a notion of what 
will come.
For the TIF format, you can check the CMYK option, which means the image will be transferred from the 
RGB to the CMYK color scheme. This is primarily useful in DTP for preparing films for color separation.



Integration into the Windows System
Once installed, Zoner Media Explorer and Zoner Viewer are integrated into the Windows system. That 
means these efficient helpers will always be at hand. The following features make them especially easy to
use with other Windows programs:
* you can drag and drop to other applications. If another currently open application also supports drag and
drop technology, and can work with the format of the file you drag, then you can drag the selected image 
or multimedia file from Zoner Media Explorer to the other application. Both Zoner Callisto and Zoner 
Viewer support this. If the target application is hidden by the Zoner Media Explorer window, drag the icon 
for the image on to the application's item on the taskbar; in a few seconds that application will be 
displayed in front.
* you can call up Zoner Media Explorer from popup menus available by right-clicking in Window's normal 
Explorer or in other Windows elements which work with files (My Computer, Network Neighborhood, the 
Desktop, and the dialogs for opening and saving documents). You can also call up the program in the 
local menu which you get by right-clicking on the Start button.
* you can call up the Zoner Viewer from popup menus for any selected image, by right-clicking on it. 
Besides the standard options offered by Windows, the options to view, copy, or convert the image have 
been added. This last is a quite useful option. This way, you can convert an image at any time, without 
having to call up the Zoner Media Explorer or Zoner Viewer.
* the standard Windows Quickview application is expanded to include extra formats supported by the 
Zoner Media Explorer.
* the Properties dialogs for appropriate images include a new section, Information, which offers 
information on the image - color depth, resolution, etc.






